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Overview

Design Goals

» Move packets from port A to port B in least time
» Low impact on CPU and other system components
» Good Control and Management of the system
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Overview

Challenges

» Packet Formats
» Variable Sized Packet Options
» Competing Uses
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Overview

Packet Format Issues: IPv4
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Overview

Routing History

v

Internet Message Processor
» Gateway
» Routers
Switches

v
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Overview

Terminology

routing Choosing an outgoing interface based on IP destination

forwarding Choosing an outgoing interface based on Layer 2
destination

switch Forwards packets to the next hop of a LAN
router Routes packets between networks, of any type
route A piece of state that describes a next hop destination
mask Used to disambiguate a route
FIB Forwarding Information Base
RIB Routing Information Base
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Overview

Traditional Router Design

v

Control Plane

Data Plane

Routing Information Base (RIB)
Forwarding Information Base (FIB)

v

v

v

George Neville-Neil (gnn@neville-neil.com) Networking from the Bottom Up: Routing and Forwarding May 11, 2011

8/57



Overview

Traditional Router Block Diagram
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Overview

FreeBSD Networking Block Diagram
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Overview

Forwarding Components

Neighbor
Discovery
IPv4 IPv6
BPF Netgraph Bridge ARP
Ethernet
if0 if1 if2 100
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Routing
Information
Base

Overview

RIB and FIB Connections

Forwarding
Information
Base

Neighbor
Discovery
IPv4 IPv6
BPF Netgraph Bridge ARP

/'
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Forwarding

Forwarding vs. Routing

» The most significant difference between routing and forwarding is
what part of the packet is inspected.
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Forwarding

Interfering with Packets

» Many components in the kernel are meant to divert or change
packets
BPF Berkeley Packet Filter used for debugging
Dummynet Testing and debugging
Bridging A software packet switch
Firewall Security
PFil Security
ALTQ Traffic Shaping and QoS
» Different components grab packets at different locations in the
packet processing pipeline
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Forwarding

Three Basic Questions

Where is the packet grabbed?
How is the packet modified?
When is the packet buffer freed?
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Forwarding

Berkeley Packet Filter

v

Captures packets as near the interface as possible
Matches packet data vs. a filter

Copies packet without modification

Requires root privileges

v

v

v
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Forwarding

BPF and Drivers

> BPF ), TAPMUST becalledfromthedrivers
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Forwarding

BPF Callgraph

1. bfp_mtap
2. bpf_filter
3. catch_packet
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Forwarding

Netgraph

v

A framework for arbitrary packet processing

Nodes implement packet transformation

Edges allow nodes to be arranged into an arbitrary graph
Currently used to implement Bluetooth and ATM network stacks

\4

\4

v
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Forwarding

Bridging

v

Spans packets at layer 2

v

Packets are copied, in software, to one or more interfaces
Need to protect against looping packets backwards
Maintains its own forwarding table

v

v
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Forwarding

Callgraph

1. bridge_input

2. bridge_span

3. GRAB_OUR_PACKETS
4. bridge_forward
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Forwarding

Packet Demultiplexing and netisr

v

The netisr implements a software interrupt handler
A holdover from before interrupt threads

Packets are normally carried through from the driver’s interrupt
thread.

Packets can be queued for protocols but this is inefficient
Protocols register a handler with the netisr system

v

v

\4

v
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Forwarding

Ethernet Packet Demultiplexing

» ether_input
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Forwarding

Fast Forwarding

v

Shortcut in IPv4 forwarding

Allows well formed packets to be forwarded more quickly
ip_fastforward()

Any diversion from the norm results in normal forwarding

v

v

v
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Forwarding

Fast Forwarding Code

» ip_fastforward
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Forwarding

Forwarding Information Base

v

Stores Layer 2 Address Information

Allows lookup of next hop hardware address
This is not routing

Used by ARP and Neighbor Discovery

v

v

v
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FIB Entries

struct llentry {
LIST_ENTRY(llentry)
struct rwlock
struct lltable
struct llentries
struct mbuf
int
time_t
uint16_t
uint16_t
uint16_t
uint16_t
int16_t
uint16_t
time_t
int

union {
uint64_t
uint16_t
#ifdef OFED
uint8_t
#endif
} 1l_addr;

/% XXX af—private? x/
union {
struct callout
struct callout
} lle_timer;

Forwarding

lle_next;
lle_lock;
«1le_tbl;
«lle_head;
xla_hold;
la_numheld;
la_expire;
la_flags;
la_asked;
la_preempt;
In_byhint;
In_state;
In_router;
In_ntick;
Ille_refcnt;

mac_aligned;
macl16[3];

mac8[20];

In_timer_ch;
la_timer;

/«x # of packets currently held =/

/* IPv6 has ND6_LLINFO NOSTATE == —2 =/

/% IB needs 20 bytes. x/
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FIB Tables

struct

lltable
SLIST_ENTRY( lltable)
struct llentries
int

struct ifnet
struct llentry =
void

void

struct llentry =
int

int

}s
MALLOC_DECLARE (M_LLTABLE) ;
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It_link;

lle_head [LLTBL_HASHTBL_SIZE];

It_af;

«Ilt_ifp;

(xIlt_new)(const struct sockaddr *, u_int);
(xIlt_free)(struct Iltable =, struct llentry x);

(xI1t_prefix_free)(struct Iltable =,

const struct sockaddr xprefix,

const struct sockaddr sxmask);
(«Il1t_lookup)(struct lltable =, u_int flags,

const struct sockaddr x|3addr);
(xI1t_rtcheck)(struct ifnet %, u_int flags,

const struct sockaddr =x);
(xI1t_dump)(struct Iltable =,

struct sysctl_req =x);
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Forwarding

FIB APls

new create a new entry, with associated locks and timers
free destroy an entry, handle locks and timers
prefix_free destroy all entries with an associated prefix and mask
richeck
lookup find a matching entry in the FIB
dump dump the entire table
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Forwarding

ARP

v

Address Resolution Protocol

RFC 826

Map an IPv4 address to a hardware address

» Runs directly on Ethernet or other layer 2 packets

v

v
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Forwarding

Protocol Diagram

Source Target
ARP Request

\
-

ARP Reply
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Forwarding

ARP Use of FIB

v

FIB is not a routing table

\4

Implemented as a hash table

\4

Each protocol has its own Link Layer Table

v

Every Link Layer Table has its own methods

George Neville-Neil (gnn@neville-neil.com) Networking from the Bottom Up: Routing and Forwarding May 11, 2011

32/57



Forwarding

ARP Lookup

» in_lltable_lookup
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Forwarding

Neigbor Discovery

RFC 4861

Maps an IPv6 Address to a hardware address
Runs on top of ICMPv6 packets

Layer 2 agnostic

Stores address mappings in the FIB

v

v

v

\4

v
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Forwarding

Neighbor Lookup

» in6_lltable_lookup
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Routing

Data Structures

» Routing Table
» Routing Entry
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Routing

Route Structure

struct route {
struct rtentry xro_rt;
struct Ilentry xro_lle;
struct sockaddr ro_dst;
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Routing

Route Entry

struct rtentry {
struct radix_node rt_nodes[2]; /x tree glue, and other values x/
/*
* XXX struct rtentry must begin with a struct radix_node (or two!)
* because the code does some casts of a ’'struct radix_node *’
« to a ’'struct rtentry *’

*/
#define rt_key(r) (*((struct sockaddr *x*)(&(r)—>rt_nodes—>rn_key)))
#define rt_mask(r) (*((struct sockaddr xx)(&(r)—>rt_nodes—rn_mask)))
struct sockaddr xrt_gateway; /= value x/
int rt_flags; /= up/down?, host/net x/
int rt_refent; /% # held references x/
struct ifnet xrt_ifp; /* the answer: interface to use x/
struct ifaddr *rt_ifa; /% the answer: interface address to use x/
struct rt_metrics_lite rt_rmx; /« metrics used by rx’ing protocols x/
u_int rt_fibnum; /% which FIB x/

#ifdef _KERNEL
/% XXX ugly, user apps use this definition but don’t have a mtx def */
struct mitx rt_mtx; /% mutex for routing entry =/

#endif

N
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Routing

Reference Counting

» Many subsystems can place a hold on a route

» Each time a hold is placed on a route its reference count is
increased

» Routes with reference counts greater than 0 cannot be freed
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Routing

Locking

» Routes are accessed from various subsystems
» Updating a route requires holding a lock on the route
» Changing the reference count requires use of the lock
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Routing

The Patricia Trie

v

Practical Algorithm to Retrieve Information Coded in Alphanumeric
The data structure that holds all routes

Each protocol has its own tree structure, rooted in a global
variable

Allows efficient storage and lookup of routes
Never used in high end, production router

v

v

\4

v
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Routing

Route Lookup

» Necessary pieces of information

Key Address we're seeking
Mask Network mask, used in backtracking
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Routing

Route Lookup Algorithm

Start at high order bit

Compare bit in Key with bit in the current Node

If bits AND to 1 take left path

else take right path

When leaf is reached and Key with leaf node’s Address

If Key AND Node Address is equal to Key we have a match
else backtrack

N o k~owDh -
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Routing

Backtracking

v

Can't find a host route? Backtrack.

Go up from failed leaf to immediate parent
Take the other path

Mask off Key’s host specific bits

If masked Key AND Node Address equal masked Key we have a
network match

v

v

v

v
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Routing

Adding a Route

» in_addroute
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Routing

Matching a Route

» in_matroute

George Neville-Neil (gnn@neville-neil.com) Networking from the Bottom Up: Routing and Forwarding May 11, 2011 46 /57



Routing

Deleting a Route

Follows a somewhat more tortuous route

v

\4

Learned routes are deleted via a timeout

\4

User set route as deleted by the route command
rtrequesti_fib

v
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Routing

Equal Cost Multipath Routing

v

Used for load balancing across routes
enabled with option RADIX_MPATH

» Nodes have lists of valid addresses

Uses a hash to select from the list of routes
Can play havoc with TCP

v

v

v
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Routing Sockets

Processing Model

v

Message passing and Event driven model

v

Uncommon in Unix like systems
Userland programs wait for events from the kernel
Events arrive as routing messages

v

v
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Routing Messages

struct rt_msghdr {

u_short
u_char
u_char
u_short
int

int
pid_t
int

int

int
u_long
struct

rtm_msglen; /%
rtm_version; /%
rtm_type; /%
rtm_index; Ves
rtm_flags; /%
rtm_addrs; /%
rtm_pid; /%
rtm_seq; /%
rtm_errno; /%
rtm_fmask; /%
rtm_inits; /%

Routing Sockets

to skip over non—understood messages */
future binary compatibility =/

message type x/

index for associated ifp =/

flags, incl. kern & message, e.g. DONE */
bitmask identifying sockaddrs in msg */
identify sender */

for sender to identify action =/

why failed x/

bitmask used in RTM_CHANGE message =/
which metrics we are initializing =/

rt_metrics rtm_rmx; /x metrics themselves x/
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Routing Sockets

User Level API

Add a route

Delete aroute
Get
Change
Lock
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Routing Sockets

Events

New Address A new address was added to the table

New Multicast Address Same as above for multicast
Miss A routing lookup failed

Interface Change An interface was modified

Interface Announce An interface was added or removed

IEEE 802.11 message Wireless specific message
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Packet Filtering

Overview

» Packet filtering interferes with packet forwarding
» Has many several:

» Firewalls
» Traffic Shaping
» Protocol Testing
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Packet Filtering

PFIL

» Packet Filtering System
» Allows relatively arbitrary hooks in packet flow

» Three choices:

» Drop
» Modify
» Continue
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Packet Filtering

PFIL locations

» Exists only in the lower layers
» Bridge

Fast Forwarding

IP Input

IP Output

IP6 Forward

IP6 Input

IP6 Output

vV VvV VY VY
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Packet Filtering

IPFW and Dummynet

» Is a consumer of PFIL
» Uses rules to decide what to do with packets
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Packet Filtering

Wrap Up

v

Forwarding and Routing are Different but Related
Forwarding Information Base

Routing Information Base

Equal Cost Multipath Routing

Routing Sockets

Packet Filtering

v

v

v

v

v
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